Introduction

A man walks down the street when he comes upon a construction site
where a group of three brick masons are busily at work. He stops to talk
to the first brick mason and asks, “What are you doing?” The brick mason
answers, “I'm putting bricks on top of other bricks.”

The man continues down the sidewalk until he comes to the second brick
mason. Again he asks the same question, “What are you doing?” The second
brick mason answers, “I'm putting some bricks together to make a wall.”

The man then walks on until he comes face-to-face with the third brick
mason. The man poses the same question to the third brick mason: “What
are you doing?” The third brick mason answers, “I'm building a beautiful
cathedral.”

Is QuarkXPress Too High-End for Me?

Right now, you may be wondering why on earth we are telling this story as
part of the introduction to a book on QuarkXPress. Good question. But, when
you think about it, the people who use QuarkXPress are a lot like those brick
masons, and QuarkXPress is a lot like the mortar and bricks used by those
brick masons to do their work.

What we are saying is this: There are all kinds of users of QuarkXPress. Some
do very simple, one-color documents. Some do moderately challenging docu-
ments, which include photos, illustrations, and complex charts. With Version 5,
some even create Web pages. Still others — like the third brick mason who was
building a cathedral — use QuarkXPress to create high-end, highly designed
and illustrated works of art.

QuarkXPress — like the mortar and bricks used by the brick masons in our
story — is a tool. Nothing more, nothing less. It works for the world’s most-
celebrated graphic designers. It also works for people who create simpler
documents, such as school newsletters.

The point is, QuarkXPress can never be too high-end for you, or for anyone
else, because you pick and choose which parts of this tool you need to use.
Also, keep in mind that if you create any type of document, you can benefit
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from the program’s features. Sure, it’s true that if your documents are simple,
you won'’t need to use all the sophisticated features in QuarkXPress. But,
when you think about it, isn’t it nice to know that these features are available
when and if you ever need them? And that you won’t outgrow the program as
you become more proficient with document design? We think so.

How to Use This Book

Although this book has information that any level of publisher needs to know
to use QuarkXPress, this book is also for those of you who are fairly new to
the field, or who are just becoming familiar with the program. What we try

to do is to take the mystery out of QuarkXPress and give you some guidance
on how to create a bunch of different types of documents. Here are some
conventions used in this book:

» Menu commands are listed like this: Style=>Type Style=>Bold.

If we describe a situation in which you need to select one menu and then
choose a command from a secondary menu or list box, we do it like this:
Choose Filer>Get Picture (or press 8+E on Mac or Ctrl+E in Windows).
After the first mention, we drop the platform reference. This shorthand
method of indicating a sequence of commands is often followed by the
keyboard shortcut, as shown in this example.

v 38: This is the Macintosh’s Command key — the most-used shortcut key.
Its Windows equivalent is Ctrl.

1 Key combinations: If you're supposed to press several keys together, we
indicate that by placing plus signs (+) between them. Thus Shift+3+A
means press and hold the Shift and 88 keys, and then press A. After
you've pressed the A key, let go of the other keys. (The last letter in the
sequence does not need to be held down.) We also use the plus sign to
join keys to mouse movements. For example, Option+drag means to
hold the Option key when dragging the mouse.

v Panes: QuarkXPress has an interface feature, tabbed panes, that you
may have seen in other applications. This is a method of stuffing several
dialog boxes into one dialog box. You see tabs, like those in file folders,
and by clicking a tab, the options for that tab come to the front of the
dialog box in what is called a pane.

v Pointer: The small graphic icon that moves on the screen as you move
your mouse is a pointer (also called a cursor). The pointer takes on dif-
ferent shapes depending on the tool you select, the current location of
the mouse, and the function you are performing.
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v Click: This means to quickly press and release the mouse button once.
On most Mac mice, there is only one button, but on some there are two
or more. All PC mice have at least two buttons. If you have a multi-button
mouse, click the leftmost button when we say to click the mouse.

+* Double-click: This means to quickly press and release the mouse button
twice. On some multi-button mice, one of the buttons can function as a
double-click. (You click it once, the mouse clicks twice.) If your mouse
has this feature, use it; it saves strain on your hand.

v Right-click: A Windows feature, this means to click the right-hand mouse
button. On a Mac’s one-button mouse, hold the Control key when clicking
the mouse button to do the equivalent of right-clicking in programs that
support it. On multi-button Mac mice, assign one of the buttons to the
Control+click combination.

v Dragging: Dragging is used for moving and sizing items in a QuarkXPress
document. To drag an item, position the mouse pointer on the item,
press and hold down the mouse button, and then slide the mouse across
a flat surface.

How This Book Is Organized

We've divided QuarkXPress 5 For Dummies into seven parts, not counting this
introduction. Each part has anywhere from two to five chapters, so you don’t
have to wade through too much explanation to get to the information you
need. Note that the book covers QuarkXPress on both Macintosh and
Windows platforms. Because the application is almost identical on both, we
only point out platform-specific information when we need to, or when we
remember to, or both.

Part I: Getting Started

Designing a document is a combination of science and art. The science is in
setting up the structure of the page: How many places will hold text and how
many will hold graphics? How wide will the margins be? Where will the page
numbers appear? And so on. The art is in coming up with creative ways of fill-
ing the structure to please your eyes and the eyes of the people who will be
looking at your document.

In this part, we tell you how to navigate your way around QuarkXPress using
the program’s menus, dialog boxes, and tabbed panes. We also show you how
to set up the basic structure of a document and then how to begin filling the
structure with words and pictures. We also tell you how to bring in text and
graphics created in separate word processing and graphics applications.
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Part II: Adding Style and Substance

Good publishing technique is about more than just getting the words down on
paper or Web page. It’s also about tweaking the letters and lines — and the
space between them — to make your pages shine. This part shows you how to
do all that and a lot more, including tips on using Required Components and
XTensions to get more out of QuarkXPress and how to get your document out
of your computer and onto some other medium, such as film or paper or the
Web. We give you some solid suggestions on how to work with all those other
people in the world who know how to help you get the job done.

Part lII: The Picasso Factor

Let’s be honest. Pablo Picasso didn’t become famous for realistically portray-
ing people. His claim to fame is based on how he took facial features and then
skewed, slanted, stretched, and shrunk them into new forms. Some folks
loved his work; others found it hard to figure out. But you had to admire the
fact that it was unique.

We named this part of the book after the famous artist because it tells not
only how to use QuarkXPress as an illustration tool, but also how to take
normal-looking text and graphics and distort them. Why would you want to
do this? Good question. The answer could be that, like Picasso, you want to
present ideas in a visually interesting way. Either that, or you want to see
how your relatives might look with their faces rearranged. QuarkXPress lets
you manipulate text and art in interesting ways, and we show you how.

Part IV: Going Long and Linking

QuarkXPress includes features that help you keep track of figure numbers,
table numbers, index entries — well, you get the idea. In fact, crafting long
documents with QuarkXPress is a piece of cake. In this section, we show you
how to handle long documents of all flavors, including those that link
together several smaller documents into a whole.

Part U: Taking QuarkXPress to the Web

It used to be that QuarkXPress was the tool for print documents. Now
QuarkXPress 5 has features that let you build Web pages — and when it
comes to building Web pages, a lot of the regular QuarkXPress rules don’t
apply. We show you how to use the new Web features to make some snazzy
pages for online use.



Introduction

Part Ul: Guru in Training

After you master the basics, why not pick up some of the tricks the pros use?
In this part, we show you how to customize QuarkXPress so that it fits you
like a comfortable easy chair. We also explain how QuarkXPress works on PCs
that use Windows and on Macs.

Part VIl: The Part of Tens

This part of the book is like the chips in the chocolate chip cookies; you
could eat the cookies without them, but you’d be missing a really good part.
It’s a part of extremes, of bests and worsts. It’s like a mystery novel that’s
hard to put down until you read the very last word. In fact, you might even be
tempted to start reading here and then go back to Chapter 1, but don’t. The
concepts in this book will make more sense to you if you read the other six
parts of the book first.

Icons Used in This Book

So that you can pick out parts that you really need to pay attention to (or,
depending on your taste, to avoid), we've used some symbols, or icons in this
book.

When you see this icon, it means we are pointing out a feature that’s new to
Version 5 of QuarkXPress.

This icon points out features that behave a bit differently on Windows
machines and Macs.

This icon alerts you to a valuable nugget of information you should store in
your memory.

If you see this icon, it means that we’re mentioning some really nifty point or
idea that you may want to keep in mind as you use the program.

5



6

QuarkXPress 5 For Dummies

NING/
g‘?‘

If you skip all the other icons, pay attention to this one. Why? Because ignoring
it could cause something really, really bad or embarrassing to happen, like
when you were sitting in your second-grade classroom waiting for the teacher
to call on you to answer a question, and you noticed that you still had your
pajama shirt on — backwards. We don’t want that to happen to you!

Sometimes things work a certain way for no apparent reason. When you see
this icon, it means you are about to read about some QuarkXPress mystery.
But don’t worry: We tell you how to solve it.

This icon tells you that we are about to pontificate on some remote technical
bit of information that might help explain a feature in QuarkXPress. The
technical info will definitely make you sound impressive if you memorize it
and recite it to your friends.

Where to Go from Here

QuarkXPress is an extremely versatile publishing tool. The time you take to
become familiar with Quark’s many capabilities will be amply repaid in your
ability to create the types of documents you want and need, from the most
basic to the most bizarre. QuarkXPress can take you anywhere you want to
go in print or online publishing. So get going!
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In this part . . .

Getting off to a great start with QuarkXPress is what
this part is about. We take you from a blank screen
to a text-filled document, helping you navigate your way
around QuarkXPress using the program’s menus, dialog
boxes, views, and tabbed panes. And we explain the
basics about how to get QuarkXPress to do what you want
it to: First you build a box and then you start to fill it with
text or graphics. All this just to get you on your way.




Chapter 1
Introducing QuarkXPress

In This Chapter
Getting familiar with menus, dialog boxes, and keyboard shortcuts

Exploring QuarkXPress’s Tool palette and Measurements palette

Wen the first personal computer shipped in the early 1980s, a quiet rev-
olution began. The turning point in that revolution was the introduction

of desktop publishing in the mid-1980s, which let anyone anywhere become

a publisher. Soon, anyone with a message could get it out to the world. That
revolutionized much of business and society. You, too, are a revolutionary. And
by buying QuarkXPress and this book, you have taken up the cause.

Over the years, QuarkXPress has become the best desktop publishing tool
around. Professionals know that, which is why they have made QuarkXPress
the corporate standard for magazine, newspaper, and catalog publishing. It

is also an effective book-publishing tool, thanks to its capability of index docu-
ments and creating tables of contents and multichapter books. Now the folks at
Quark have upped the ante again with the release of QuarkXPress 5. In addition
to hosting a boatload of new desktop-publishing features (including the long
delayed, though very welcome inclusion of a table-making tool), 5 boasts an
entire suite of publishing tools for the World Wide Web, including tools for
creating forms, radio buttons, hyperlinks and “hot spots.” In short, if ever

you wanted to limit your publishing options to just one or two applications,
you certainly can’t go wrong choosing QuarkXPress 5 to be among them.

You may feel a little daunted by QuarkXPress. Relax. Throughout this book, we
walk you through the program to familiarize you with all it has to offer. You
may be a bit intimidated by the vast layers of panes, palettes, tools, and menus
you see before you. Don’t be. Working with QuarkXPress is like working with

a new person at the office — things may be awkward at first, but after you get
to know each other, you find you can do great things together.
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A Familiar Interface

First, you’ll no doubt notice that the QuarkXPress interface bears a strong
resemblance to the features used by other Windows and Macintosh programs.
If you use other programs, you already know how to use QuarkXPress compo-
nents such as file folders, document icons, and the set of menus at the top of
the document window.

You create a document by choosing FilecoNewr>Document or open an existing
document by choosing Filec>Openr>Document. The program displays a
window similar to the ones shown in Figure 1-1.

This book is for both Windows and Macintosh users. We use both Windows
and Mac screen shots throughout the book — unless the two platforms’
versions of QuarkXPress have significant differences. In those cases we show
screens from both.

When you display a document in either Windows or Macintosh, you’ll notice
a few visual elements:

v The ruler origin box lets you reset and reposition the ruler origin, which
is the point at which the side and top rulers are 0 (zero).

v The name of the open document appears on the title bar, located below
the menu bar on the Mac and above the menu bar in Windows. You can
move the document window around in the screen display area by clicking
and dragging the title bar.

v If you have reduced or enlarged a document, clicking the zoom box on
the Mac or the restore box in Windows, at the top right corner of the
document window, returns it to its previous size.

» You can make a document all but disappear by minimizing it (in Windows)
or turning it into a window shade (on the Mac). To minimize a document,
click the minimize box in the document’s title bar. To make a document
into a window shade, double-click its title bar or click its WindowShade
box on the Mac.

v The vertical and horizontal rulers on the left and top of the window
reflect the measurement system currently in use.

v The pasteboard is a work area around the document page. You can
temporarily store text boxes, picture boxes, or lines on the pasteboard.
Items on the pasteboard do not print.

v QuarkXPress displays a shadow effect around the document page. The
shadow indicates the edges of the document.

v If you select Automatic Text Box in the New dialog box (which you
access by selecting New Document from the File menu), a text box
appears on the first page of the new document.
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v Clicking and dragging the size box on the Mac resizes the document
window as you move the mouse. In Windows, you can drag any side of
the window to resize it.

v The View Percent field shows the magnification level of the page that’s
currently displayed. To change the magnification level, enter a value
between 10 and 800 percent in the field; then press the Return key or
click elsewhere on the screen. Press Control+V on the Mac or Ctrl+Alt+V
in Windows to highlight the View Percent field.

v Switch pages using the page pop-up.

v Use the scroll bars, boxes, and arrows to shift the document page around
within the document window. If you hold down the Option or Alt key
while you drag the scroll box, the view of the document is refreshed as it
“moves.”

v Close a document by clicking its close box. On the Mac, you can also use
the shortcut 88+W; in Windows, use Alt+F4.

Menus

The menu bar appears across the top of the document window. To display a
menu on a Mac, click the menu title and, if you're using an older version of
operating software, hold down the mouse button. (In Windows or Mac OS 9
or later, just click the menu title; you don’t need to hold down the mouse
button.)

From the menu, you can select any of the active menu commands.
QuarkXPress displays inactive menu commands with dimmed (grayed-out)
letters. When commands are dimmed, it means that these commands are not
currently available to you — they’re inactive.

To select one of the active menu commands, hold down the mouse button
as you slide through the menu selections. (As you get used to the program,
you can avoid using menus by using the keyboard equivalents for menu
selections instead. Keyboard equivalents are displayed to the right of the
command names in the menu.)

If an arrow appears to the right of a menu command, QuarkXPress displays

a second, associated menu when you choose that command. Sometimes this
secondary menu appears automatically when you highlight the first menu
command; other times, you must continue to hold down the mouse and slide
it to the submenu name in order to activate the menu. This may sound a little
confusing on paper. But go ahead and try it. You'll find it’s no big deal. (Again,
in Windows or Mac OS 9 or later, you don’t need to hold down the mouse
button; just click the arrow to make the submenu appear.) Figure 1-2 shows
the Style menu and the secondary menu that appears when you select the
Font menu command.
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Dialog boxes

Some menu commands are followed by a series of dots called an ellipsis (. . .).
If you choose a menu command whose name is followed by an ellipsis, a dialog
box appears. Figure 1-3 shows a dialog box. Dialog boxes give you a great deal
of control over how QuarkXPress applies specific features or functions to your

document.

Some dialog boxes also contain submenus. If a menu has a submenu associ-
ated with it, an arrowhead appears to the right of the menu entry. In addition
to submenus, QuarkXPress includes several pop-up menus, which appear
when you make certain selections in a dialog box. Figure 1-3 shows a pop-up

menu for text justification.
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Working with contextual menus

All versions of Windows since 1995, as well as
Mac OS 8 and later, use a technique called con-
textual menus to save you time. By right-clicking
an item in Windows, or Control+clicking on the
Mac, you got a menu of options just for that item.
This saves you time going through menus, dialog
boxes, and palettes. QuarkXPress 4, unfortu-
nately, really skimped when it came to context
menus. That has changed in QuarkXPress 5.
Now you can use context menus in relation
to virtually everything in and around a
QuarkXPress document. To do so, simply press
and hold the appropriate keyboard command,
and then click on the object you want to modify.

On the Mac, the default keyboard command to
launch a context menu is Control+click. You
can, however, change this keyboard command
to Control+Shift+click by clicking Zoom in the

Control Key area of the Preferences dialog box
(Edit=>Preferences=>Interactive). If you have a
multibutton mouse, you can set the right-hand
mouse button to be the Control+click or
Control+Shift+click command.

To display a context menu in Windows, just
right-click on the object you want to modify.

Context menus are available for a document's
pasteboard, rulers, empty space on a document
page, picture boxes, text boxes and text paths,
lines, tables, and even many of the palettes.
Because they require less mouse movement
and menu searching, and require less brain
power (something we all want to conserve on!),
context menus may soon replace keyboard
shortcuts as the beeline of choice among
QuarkXPress users.

QuarkXPress uses tabs, a semi-new kind of dialog box that merges several
dialog boxes into one. In fact, you’ll often see six or seven of these tabs —

similar to what you see on a file folder in an office cabinet — in a single dialog
box. Like the file folders in an office cabinet, these tabs keep a large amount
of stuff organized in one tidy spot. Click the tab, and it comes to the forefront,
showing you the options for that tab (refer to Figure 1-3). You simply work
with each tab you want within the dialog box.

Keyboard shortcuts

You can select some QuarkXPress functions through pull-down menus, some
through palettes, some through keyboard shortcuts, and some through all
three options. Most new users begin by using menus because menus are so
readily available and familiar. But as you become more comfortable using
the program, you may want to save time by using the other options as well,
particularly the keyboard shortcuts.

Suppose that you want to move from page one of a document to page three.
You can change pages by choosing Go To from the Page menu, or you can use
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the keyboard shortcut: Press and hold the Command key (88) or Ctrl key while
you press the J key. In this book, we write this key combination as follows:

&8 +J (Macintosh shortcut) or Ctrl+J (Windows shortcut). The Macintosh
shortcut appears first, followed by the Windows shortcut. If the two plat-
forms use the same shortcut, we list the shortcut just once.

In most cases, the Mac’s 8 key and the Windows Ctrl key are the same, as are
the Mac’s Option key and the Windows Alt key. Shift is the same on both,
whereas the Control key exists only on the Mac and has no Windows equiva-
lent. On both platforms, the Return key is the same as the Enter key (some
keyboards use one word whereas some keyboards use the other); in neither
case do we mean the Enter key that appears on the keyboard’s numeric
keypad at the far right of the keyboard. (To avoid confusion, we say “Return”
for the key that inserts a new paragraph or activates a command, and we say
“keypad Enter” when we mean the key on the numeric keypad.)

The Tool and Measurement Palettes

|
Figure 1-4:
The Quark-
XPress Tool
palette.
|

\\J

One of the coolest features of the QuarkXPress interface is its palettes, which
let you perform a wide range of functions on an open document without having
to access pull-down menus. Like context menus and keyboard shortcuts,
palettes are huge time-savers, and you’ll undoubtedly find yourself using

them all the time. Without a doubt, the Tool palette (see Figure 1-4) and the
Measurements palette are the most commonly used. In fact, you’ll probably
keep these two palettes open all the time. You can find both palettes by choos-
ing View>Tools=>Show Tools, and Views>Show Measurements. The following
list describes the contents of the two palettes.

kEEEEERRCE]

To use a tool on the palette, you first need to activate the tool. To activate
a tool, just click it. Depending on which tool you select, the cursor takes on
a different look to reflect the function the tool performs (see “A Myriad of
Mouse Pointers” later in this chapter). When you click the Linking tool, for
example, the cursor looks like links in a chain.

15
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Throughout the book, we explain in greater detail many of the functions you
can perform with the Tool palette. But, for now, the following sections give
brief descriptions of each tool.

Item tool

The Item tool controls the size and positioning of items. In other words, when
you want to change the shape, location, or presence of a text box, picture box,
or line, you use the Item tool. We discuss text boxes, picture boxes, etc. in
detail later in this book. For now, just keep in mind that the Item tool lets you
select, move, group, ungroup, cut, copy and paste text boxes, picture boxes,
lines and groups. When you click the Item tool on a box, the box becomes
active, which means that you can change or move the box. Sizing handles
appear on the sides of the active box; you can click and drag these handles to
make the box a different size.

Content tool

The Content tool controls the internal aspects of items on a page. Functions
that you can perform with the Content tool include importing (putting text into
a text box, or putting a picture into a picture box), cutting, copying, pasting,
and editing text.

To edit text in a text box, select the Content tool. Then select the areas of text
you want to edit by clicking and dragging the Content tool to highlight the
text or by using different numbers of mouse button clicks, as follows:

v To position the cursor: Use the mouse to move the I-beam pointer (it
looks like a large capital /) to the desired location and click the mouse
button once.

1 To select a single word: Use the mouse to move the pointer within the
word and click the mouse button twice.

1 To select a line of text: Use the mouse to move the pointer within the
line and click the mouse button three times.

1 To select an entire paragraph: Use the mouse to move the pointer
within the paragraph and click the mouse button four times.

1 To select the entire document: Use the mouse to move the cursor any-
where within the document and click the mouse button five times.

When the Content tool cursor changes to a hand shape, you can use the tool
to move the contents of the picture box around the inside the picture box.
You can also use it to manipulate the picture’s contents, such as applying
shades, colors, or printing effects. Again, we discuss the in and outs of text
boxes and picture boxes in more detail later in this book. For now, just keep
in mind the Content — and the aforementioned Item tool — go hand-in-hand
with these boxes.
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Rotation tool

Use the Rotation tool to rotate items on a page. You can click a text box, pic-
ture box or line, and rotate it by dragging it to the angle you want. You also
can rotate items on a page in other ways, which include using the
Measurements palette and the Modify command in the Item menu.

Zoom tool

You may want to change the magnification of a page on-screen. For example,
you may be making copy edits on text that is set in 8-point type; increasing the
displayed size of the text makes it easier to see what you are doing as you edit.
The Zoom tool lets you reduce or enlarge the view you see in the document
window. When you select the Zoom tool, the cursor looks like a small magnify-
ing glass; when you hold the cursor over the document window and click the
mouse button, QuarkXPress increases or decreases the magnification of that
section of the screen in increments of 25 percent. (To increase magnification,
choose the Zoom tool and click on your document. To decrease magnification,
choose the Zoom tool, hold the Option or Alt key, and click on your document.)

Another way to change the magnification of the page is to enter a percentage
value in the bottom-left corner of the document window (refer to Figure 1-1);
when a page is displayed at actual size, the percentage is 100. QuarkXPress
lets you select any viewing percentage, including those in fractions of a per-
cent (such as 49.5 percent), as long as you stay within the range of 10 to 800
percent.

Text Box tools

QuarkXPress needs to have a text box on the page before it lets you type text
into your document or import text from a word processor file. You can
instruct QuarkXPress to create text boxes on each page of the document
automatically, or you can create a text box manually — which you do by
using the Text Box tools. We discuss Text Box tools more in Chapter 3.

To create a text box, select the desired Text Box tool and place the cursor
where you want the box to appear. Click the mouse button and hold it down
as you drag the box to size. More on this in Chapter 3.

Notice the arrow to the right of the Text Box tool’s icon: This arrow indicates
that if you click and hold down on the Text Box tool, a pop-up menu appears
to show alternative Text Box tools. Select any of these alternative tools, and
it becomes the default tool shown in the Tool palette. The seven Text Box
tools (see Figure 1-5) function as follows:

1 Rectangle Text Box tool: Produces the standard rectangles in which
most text is placed. The Rectangle Text Box tool should be the default
tool for most users. To get a perfectly square text box, hold down the
Shift key while drawing.
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* Rounded-Rectangle Text Box tool: Produces text boxes with rounded
corners. You can adjust the degree of rounding, called the corner radius,
in the Modify Section of the Tools Preferences dialog box. Access the
Modify section by choosing Edit=>Preferences>Toolsr>Modify. To get a
perfectly square text box, hold down the Shift key while you draw it.

1 Oval Text Box tool: Produces an ellipse. To create a perfect circle, hold
down the Shift key while drawing your oval.

1 Concave-Corner Text Box tool: Produces boxes that are “notched out”
in the corners. You can adjust the degree of “notching,” technically
referred to as the corner radius, in the Modify Section of the Tools
Preferences dialog box. Hold down the Shift key while drawing to get a
perfect square.

1 Beveled-Corner Text Box tool: Produces boxes that have beveled corners
as if they’ve been sheared off by diagonal lines. You can adjust the degree
of “shearing,” also referred to as the corner radius, in the Modify Section of
the Tools Preferences dialog box. To get a perfectly square beveled text
box, hold down the Shift key while you're drawing the box.

v~ Bézier Text Box tool: Named after the renowned French engineer, Pierre
Bézier, this tool lets you produce polygons (shapes composed of a series
of flat sides) and polycurves (shapes composed of a series of curves),
as well as shapes that combine both sides and curves. This tool works
differently than the other Text Box tools: Rather than holding down the
mouse, you click and release at each corner (or node, in graphics-
speak). When you want to complete the box, return to your first node
and click on it. (Hint: You know the tool is working when the pointer
changes into a circle from the normal cross.) If you click and drag a little
at each desired node, you'll see the Bézier control handles appear.
These are the handles that let you create a curve. You can have both
straight and curved sides based on how you use the mouse at each
node. The best way to learn to use Bézier curves (unless you are Bézier
himself) is to experiment with them, and get a feel for how they work.
(If you want to convert a straight side to a curve, you can do so, as we
describe in Chapter 4.)

v Freehand Text Box tool: Produces curved shapes — shapes composed
of a series of curves. The box takes shape as you move the mouse, as if
your mouse were a pen tracking on paper. To complete the box, you
usually bring the mouse back to the origin point and then release the
mouse button. (Notice how the pointer changes to a circle from the
normal cross.) If you release the mouse button before you return to the
origin point, QuarkXPress automatically draws a straight line from
where you released the mouse to the origin point. Using this tool, too,
requires practice — not to mention a steady hand.
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Picture Box tools

Picture boxes hold graphics that you import from graphics programs. As with
text, QuarkXPress needs a box — in this case a picture box — on the page
before it can let you import and manipulate a graphic on a page. You can
create a picture box manually, using one of four of QuarkXPress’s Picture Box
tools. These tools work very much like the Text Box tools. You choose the
Picture Box tool you want to use from the Picture Box pop-up menu in the
Tool palette, place the cursor where you want the box to appear, click and
hold the mouse button, and drag the box to size. (We talk more about this in
Chapter 3.) The following list describes the Picture Box tools in detail:

1 Rectangle Picture Box tool: Produces the standard rectangles that most
pictures are placed in. This should be the default tool for most users. To
get a perfectly square text box, hold down the Shift key while you draw.

+* Rounded-Rectangle Picture Box tool: Produces text boxes with rounded
corners. You can adjust the degree of rounding, called the corner radius,
in the Modify Section of the Tools Preferences dialog box. To get a
perfectly square text box, hold down the Shift key while you draw.

v Oval Picture Box tool: Produces an ellipse. To create a perfect circle,
hold down the Shift key while drawing your oval.

1 Concave-Corner Picture Box tool: Produces boxes that are “notched
out” in the corners. You can adjust the degree of “notching,” technically
referred to as the corner radius, in the Modify Section of the Tools
Preferences dialog box. Hold down the Shift key while drawing to get a
perfect square.

1 Beveled-Corner Picture Box tool: Produces boxes with beveled corners,
as if they’ve been sheared off by diagonal lines. You can adjust the
degree of “shearing,” also referred to as the corner radius, in the Modify
Section of the Tools Preferences dialog box. To get a perfectly square
beveled text box, hold down the Shift key while you draw.

1 Bézier Picture Box tool: Produces polygons (shapes composed of a
series of flat sides) and polycurves (shapes composed of a series of
curves), as well as shapes that combine both sides and curves. This tool
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works differently than the other Picture Box tools: Rather than holding
down the mouse, you click and release at each corner (or node, in graph-
ics-speak). When you want to complete the box, return to your first node
and click on it. (Hint: You know the tool is working when the pointer
changes into a circle from the normal cross.) If you click and drag a little
at each desired node, you’ll see the Bézier control handles appear.
These are the handles that let you create a curve. You can have both
straight and curved sides based on how you use the mouse at each
node. The best way to learn to use Bézier curves (again, unless you are
Bézier himself) is to experiment with them, and get a feel for how they
work. (If you want to convert a straight side to a curve, you can do so,

as we describe in Chapter 4.)

v Freehand Picture Box tool: Produces curved shapes — shapes com-
posed of a series of curves. The box takes shape as you move the
mouse, as if your mouse were a pen tracking on paper. To complete the
box, you usually bring the mouse back to the origin point and then
release the mouse button. (Notice how the pointer changes to a circle
from the normal cross.) If you release the mouse button before you
return to the origin point, QuarkXPress automatically draws a straight
line from where you released the mouse to the origin point.

The Table tool

Longtime QuarkXPress users worldwide breathed a collective sigh of relief
when Quark announced it would include a Table tool with QuarkXPress 5.
And understandably so. Despite the tons of sophisticated features
QuarkXPress has amassed in the last decade and a half, a tool for creating
tables quickly and efficiently has been conspicuously absent. Now, however,
those same-said users have cause to celebrate, because directly below the
Picture Box tool in the Tools palette, they will find the Table tool — the
answer to their publishing prayers.

The Table tool lets you organize data into rows and columns — a “table,” if you
will. Creating a table is very much like creating a text or picture box. You simply
choose the Table tool in the Tool palette, place the cursor where you want the
table to appear, click and hold the mouse button, and drag it until the table is
the approximate size you want. The Table Properties dialog box appears, asking
you the number of rows and columns you want to include in your table, and
whether you want to fill the individual spaces of the table, called “cells,” with
text or picture boxes. After you create your table, you can adjust it by choosing
[temr>Modify and selecting options in the Modify dialog box and/or choosing
[temr>Table and selecting options in the Table pop-up menu that appears. We
discuss creating and modifying tables in more detail in Chapter 8.

The Line tools

The four Line tools in the Line Tools pop-up palette let you draw — you
guessed it — lines. After you draw a line, you can change its thickness (called
“weight”) and/or style. A line style is, for example, a dotted line — like the
ones people sign in movies all the time.
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1 Orthogonal Line tool: Produces straight lines that are completely
horizontal or vertical.

v Diagonal Line tool: Produces straight lines at any desired angle. If you
hold down the Shift key while drawing diagonal line, the line is con-
strained to be perfectly horizontal, perfectly vertical, or at a perfect
45-degree angle. (Note that the QuarkXPress manual simply calls this
the Line tool, but we use the name Diagonal Line tool so that you don’t
mix it up with the other three Line tools.)

v~ Bézier Line tool: Produces both straight and curved lines, much like the
edges created with the Bézier Text box and Bézier Picture Box tools. A
section of a line will be straight or curved, depending on how you use
the mouse at each node.

* Freehand Line tool: Produces curved lines that follow the motion of
your mouse — similar to drawing with a pen on paper.

As with the Text Box and Picture Box pop-up palettes, you can change the
arrangement of the Tool palette’s Line tools to suit your style.

To use any of the Line tools, click the tool to select it and position the cursor
at the point where you want the line to begin.

v For the Diagonal Line, Orthogonal, and Freehand Line tools, click and
hold down the mouse button as you draw the line. When the line is
approximately the length you want, release the mouse button.

v For the Bézier Line tool, click at each point, as described for the Bézier
Picture Box and Text Box tools. If you click and drag for a little bit at
each desired node, you see the Bézier control handles appear that let
you create a curve. You can have both straight and curved sides based
on how you use the mouse at each node — again, it is suggested you
play around with this tool to get the hang of it. After you draw a line, use
the Measurements palette to select the line weight and line style.

Text Path tools

In QuarkXPress 5.0, you can draw four kinds of text paths — lines that text
will follow — to create text that flows in any direction, instead of being con-
fined within a text box. The four Text Path tools work much like the Line
tools, and like the line tools, they reside in their own pop-up palette in the
Tool palette. They are:

v Freehand Text Path tool: Produces curved text paths that follow the
motion of your mouse — similar to drawing with a pen on paper.

1 Orthogonal Text Path tool: Produces straight text paths that are com-
pletely horizontal or vertical.

1 Bézier Text Path tool: Produces both straight and curved text paths, much
like the edges created with the Bézier Line tool. A section of a line will be
straight or curved, depending on how you use the mouse at each node.
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v Line (or Diagonal) Text Path tool: Produces straight text paths at any
desired angle. If you hold down the Shift key while drawing, the paths are
constrained to be perfectly horizontal, perfectly vertical, or at a perfect
45-degree angle. (Note that the QuarkXPress manual calls this simply the
Text Path tool, but we use the name Line [or Diagonal] Text Path tool so
that you don’t mix it up with the other three Text Path tools.)

Linking and Unlinking tools

Directly beneath the Tool palette are the Linking tool (above) and the
Unlinking tool (below). The Linking tool lets you link text boxes together so
that extra text flows from one text box into another. The Unlinking tool lets
you break the link between text boxes. Linking is particularly useful when
you want to “jump” text — for example, when a story starts on page one and
jumps to (continues on) page four. We cover linking and unlinking text boxes
in-depth in Chapter 3.

Scissors tool

Introduced in QuarkXPress 4.1, the Scissors tool lets you “cut” lines you
have created with the Text Box, Picture Box, or Line tools. For example, you
can use the Scissors tool to split a single line into two separate lines, or to
remove the corner of a box. This tool also comes in handy when you want to
edit a shape you've created with the Freehand Text Box, Freehand Picture
Box, or Freehand Line tool. You can cut lines made with the Text Path tools,
too, although any text on the text path will remain linked — even if it is split
into two entirely separate parts.

The Measurements Palette

The Measurements palette was first developed by Quark and is now widely
imitated by other software developers. This palette is one of the most signifi-
cant innovations to take place in the evolution of desktop publishing, and
(honest!) you'll use it all the time. The Measurements palette gives you pre-
cise information about the position and attributes of any selected page ele-
ment, and it lets you enter values to change those specifications. If you want
to see the Measurements palette, you need to have a document open as you
choose View=>Show Measurements, or press F9.

The information displayed in the Measurements palette depends on the ele-
ment currently selected. When you select a text box, the Measurements palette
displays the text box position coordinates (X: and Y:), size (W: and H:), amount
of rotation, and number of columns (Cols:), as shown in Figure 1-6. By clicking
the up and down arrows on the palette, you can modify the leading of the text
box (or you can simply type a value in the space next to the arrows); click the
right and left arrows to adjust kerning or tracking for selected text. (If you're
unfamiliar with these typographic terms, check out Chapter 5.)
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Figure 1-7:
The
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Specify text — left, center, right, or justified — by using the alignment icons.
In the type section of the palette, you can control the font, size, and type
style of selected text.

For a picture box, the Measurements palette displays different information. In
Figure 1-7, the Measurements palette shows the position of the box (X: and
Y:), its size (W: and H:), the amount it is rotated, its corner radius, its reduc-
tion or enlargement percentage (X%: and Y%:), its repositioning coordinates
(X+: and Y+:), the amount of picture rotation within the box, and the amount
of slant.
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For a line or text path, the Measurements palette (see Figure 1-8) displays the
location coordinates (X: and Y:), line width, line style, and endcap (line
ending) style. The line style pop-up menu lets you select the style for the line.
Note that if you select a freehand or Bézier line, the Endpoints section of the
Measurements palette will be replaced with an icon that controls the line’s
rotation.
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If you select a Bézier or freehand element’s node or curve, you get controls for
the nodes, as shown in Figure 1-9. Chapter 11 explains what the controls do.
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